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A TOUR OF THE SYSTEM

For the following tour, you should follow along with the EKHO SMS running, using the
test data supplied. The tour will take you through the various forms and activities of the
SMS. Features of the user interface will be explored.

Get the system running by selecting the EKHO SMS system from the Start taskbar. You
may get asked to login. If so, login as the administrator user name (the password is
admin unless you changed it after installation, as instructed). When it has started, you
will have a screen with a menu across the top and just below that, the taskbar. The
main menu and taskbar are shown below, along with the File and Administration menus.
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Select User Preferences from the File menu, then click on the Use Test Data check
box so that the system is accessing the data we have supplied. Remember to uncheck
this when you want to start working with your own data.

The toolbar is a quick way to access the most commonly used items on the
Administration menu. The Edit menu, which is shown disabled, is used to cut and paste
text on forms. The Window menu is used to select among forms on the screen if some
are hidden behind others — you can have several forms on the screen at once. The
Navigation menu provides a method of moving through the records displayed on a form,
although each form will have a set of navigation buttons on it for this purpose.




1. The Holidays Form

We will first explore the Holidays form, used to tell the system about those days that you
will be closed. Click on the Administration menu, then select the Maintain List of

Holidays item to bring up the form. The spinner at the top lets you select the year for
which you want to schedule holidays. Clicking on the arrows increases or decreases the
year, or you can click on the date field and enter a year directly. Select 1998. You will
see that we have already scheduled Christmas, but you want to close on Boxing Day as
well. Click the New button, and another line will appear on the form. Type the name of
the holiday (“Boxing Day”) in the field where it says “Description”, then double-click on
the date field to bring up a calendar that you can use to select the date for the holiday.
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Select the month (December) and year (1998) from the calendar by using the left and
right arrows to move one month at a time, or click on the arrows on the month and year
fields to select directly. Click on the day (the 28™); the calendar will close, and the date
will appear on the form. Note that you can only select dates in the year for which you
are scheduling holidays. Click Save to save your changes. On all forms, you must save
in order for your changes to take effect. If you try to close the form, or move to another
record, the system will ask you if you want to save your changes first.

Anywhere in the system that you need to enter a date, double-clicking on the date field
will bring up a calendar. Rather than bringing up a calendar to change a date field, you
can use the plus and minus keys to change the days, the PgUp and PgDn keys to
change the months, and Ctrl-PgUp and Ctrl-PgDn to change the years.

Now close the Holidays form by clicking on the close box in the top right corner of the
form (it has an “X” in it).



2. The Course Form

Now that we have noted when you are not working, let's set up some things for you to
do when you are. Click on the Course button on the toolbar to bring up the course form.

% Course:1 - 3D Studio Max Level 2
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The title bar of the form shows the name of the form, a number showing which copy of
the form this is (you can have several course forms open at once), and the name of the
course. Below that is the course number, the date this record was last changed, and a
green box labelled “Drag Zone”. Several forms have this. It is used when you want to
“drag and drop” information from one form to another. For example, you can drop a
course onto the calendar form, and the calendar will then show only the classes
scheduled for that course. We will explore drag and drop later.

There are three names shown for the course. When you create a new course and fill in
the Name field, the other two name fields will be filled in with the same value. The

Name field is the name that you will use when selecting this course in other forms; it
can be an abbreviated name. The Formal Name field is used on certificates and other
places where the full name should be used. The Calendar Name will be used on the
calendar form and printout. Since there is limited space, a shorter name is necessary.
The size of the field on the form is about right. If the name you enter fits in the box, it
should fit the calendar. Check it by examining the calendar form and a printout of the
calendar, and adjust if necessary.

The Hours field must be filled in. It is the number of hours that this course requires. The
system assumes that a full day is 7.5 hours, and that morning, afternoon, or evening
sessions are 3.75 hours (a half-day), thus the amount you enter should be a multiple of
half or full days. The calendar uses this information to tell you if you have scheduled
enough sessions for a class.



The Cost field is used by the invoicing module to provide a default for the cost.

The obsolete box, when checked, prevents this course from appearing in the list of
courses that other forms display for you to select from. Rather than deleting a course
when you no longer offer it, mark it as obsolete.

The List Courses to Select From button will drop down a list of all the courses; click
on the one you want and it will be displayed. You can use the navigation arrows to
display the other courses as well.

Now click on the Waiting List tab.

¥ Course:1 - 3D Studio Max Level 2
Course [nfarmation Wiaiting List Schedule
Student Employer Wanted Sess(Motesg |~
| M{Michaud, Alain ka0 Infasystems Canada|Maon Mar 11,1333 Tes
Add | Remove | Print Envelopes | " Show More Info

This is a grid showing the people who want to take the course some time in the future.
The Wanted field is when the person wants to take the course. It is a date field, thus
double-clicking will bring up a calendar. The session field shows the time of day wanted
— day, AM, PM, or Evening. Clicking in this field displays a list to chose from. If the time
is not important, it can be left blank. Clicking on the notes field brings up a window into
which you can type additional information. This can be used to note when you have
contacted the person, for example.

Clicking on the headers at the top of the grid (“student”, “Employer”, ...) will sort the grid
on that column. The header of the column upon which the grid is sorted is highlighted in
green.

If you right-click on a field in a grid, a small menu may pop up, allowing you to perform
some action on the field selected. If you right-click on an employer, a menu pops up
(“Edit this Item”) allowing you to bring up the Company form for that employer. If you
right click on a student, a menu allows you to bring up the student form for the student,
print an envelope for the person, or to display a small form that has the student’s name,
employer, home and work phone numbers. This is handy when you are using the
waitlist for marketing purposes. Clicking on the Show More Info box brings up this



same information form, but the form will stay up and change as you select different
students in the grid.

The Print Envelopes button brings up a small form that allows you to print envelopes
for everyone on the waitlist. Selecting Print an Envelope from the right-click menu

brings up the same form, but will only print one envelope.
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This form allows you to select an envelope size (the default is the one you set up in the
System Setup form during installation). You can chose to have your return address
printed or not. Checking the Select a Printer box will cause a Windows printer selection
dialog box to appear before printing occurs. This allows you to select a different printer
for envelopes. Click on the Print button to print the envelope(s).

Note that you may have to use the System Setup form to fine-tune the positioning of
the addresses on the envelopes.

You can remove people from the wait list by selecting the person in the list (click on the
name, or use the arrow keys on the keyboard), then clicking on the Remove button.

You will always be asked to confirm delete operations — just in case.



The Schedule tab brings up a page showing the classes that are scheduled for this
course.

¥ Course:1 - 3D Studio Max Level 2

Course [nfarmation Wiaiting List Schedule

{Read-Only)
Class [Start Finish Size |Room —
TMon Jan 11,1998 |Thu Jan 14,1999 2-Room 107

-

Show Calendar for Selected Class

Only classes with a start date later that 30 days ago are shown. Right-clicking on the
class number will pop up a menu allowing you to display the class form. You can show
the calendar form for the selected class by selecting the class and then clicking the
button at the bottom of the page.

Note that this table is read-only. You cannot change it.

Close the Course form by clicking on the close button (the X in the top right corner).



3. The Student Form

Click on the Student button on the toolbar (or select Student from the Administration
menu) to get the student form.
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The first page is used to select a student to process. There is a list of students from
which you can select by clicking in the list, then using the slider bar at the right, or the
arrow keys to move to the desired student. Then double-click with the mouse or click
on the Display Student button. Or you can click in the box just below the list, and start
typing the surname of the student. As you type, the system will fill in the first name on
the list that matches the letters you have typed, and the list will highlight the name in
yellow. When you have typed enough to select the desired student, press the Enter
key, or click on the Display Student button. If you need to type more than just the
surname (the Smiths come to mind!), follow the surname with a comma, then start
typing the first name (don’t type a space after the comma).

The list's default order is alphabetic by surname and first name. By clicking on one of
the buttons on the List Ordering box, you can have the list ordered by the date that the
records were changed (it lists the newest date first). This is useful if you want to see
what has been changed recently. You can see the list displayed in the order in which
the students were entered, the most recent first. This is useful to get access to new
students.

To create a new student, click the Create New Student button. You will be asked if you
have checked to make sure the person has not already been entered. You should first
check the name in the list — you don’'t want to have duplicate entries.



After selecting a student, or asking to create a new one, the Student page will appear.

in Michaud
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Note that the title bar contains the name of the form, and the number and name of the
student. The student number and the change date appear next, along with a drag zone
box that can be used to drop a student on another form (such as the course form
waiting list). Let’s try this. Bring up the Course form’s Wait List page, and move it so that
both forms are visible on the screen. Position the mouse over the green Drag Zone
box, hold the left mouse button down; the cursor will change to the drag-drop cursor —
an arrow with a plus sign. Now move the mouse (keep the left button down) over the
walit list. When the mouse is over the grid on the wait list, the grid background will turn
green - this is the system’s way of informing you that this is a valid place to drop
whatever it is that you are dragging. If you drag something that is not valid (such as
dragging a course over the wait list), the background will turn red. Now that the mouse
is over the green wait list, release the mouse button, and the student will now appear in
the wait list.

To change a field, click on it with the mouse, or use the Tab keys to move to it. Note
that when you do this, field changes colour — white on a dark blue background. This
shows that the text has been selected, and anything you type will replace the selected
text. Using the mouse, you can select only part of a field to change. Of course, you
need to save your changes.

Note that the Prov/State and Country fields will pop up a list from which you can make
a selection either with the mouse, or by typing the first few letters.

The navigation arrows at the bottom left let you move through the student in the order
that they appear in the list on the selection page.

The Print button will bring up a small menu that allows you to print an envelope for the
student. (The other items on this menu haven’t been implemented yet).



Now bring up the Employer page.

4% Students:1 - 38 Alain Michaud
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It shows information about the student’s employer. Note that most of the fields on this
page have a grey background; this indicates that you cannot enter data into these fields.

Clicking on the ID field displays a pop-up list of possible employers; at the very top of
the list are three special ones: (none), (unemployed) and (self-employed).

The fields at the bottom of the page, such as Title, contain information about the
student pertaining to the work environment.

After making changes to this page (or any other), you must save the student record by
using the Save button on the Student page. Or you can use a shortcut for saving — use

the Ctrl-S key combination. Ctrl-E (for Escape) can be used to cancel your changes



The Misc. page is shown below.

4% Students:1 - 38 Alain Michaud
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It displays addition student information. You can use the Type field to note whether a
student is a current, former, or prospective student. We don’'t make use of this
information at present. You can prevent the student from being sent mailings or faxes
when you use other modules in the system to send mass mailings or faxes to your
students. You can track where the student heard about your school. Select an item from
the list, or if you want to add a new item, just type it into the field directly. The new item
will be kept in the list for future use. The system does not currently make use of this
information.

The Interests page lets you note in which courses the student has expressed an
interest.

4% Students:1 - 38 Alain Michaud
Selection Criteria | Sludentl Empluyerl Misc.  Interests |Qlasses | Wait List

Course - Add |

AutoCAD 14 Level 1

wAUtoCAD 14 Level 2 Remove |
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The Add button brings up a list of courses from which you can select. Remove a course
from the interest list by selecting it in the list, then clicking the Remove button.



The Classes page shows the classes for which this student is registered.

4% Students:1 - 38 Alain Michaud

Selection Criteria | Sludentl Empluyerl Misc. | Interests | Wait List

Clasg|Course |Start |Finish |Imr|:|i|:e |;
4 ALtaCAD 14 30 Mon Dec 71898 Thu Dec 10,1938

Note that the fields all have a grey background, indicating that you can’t change any of
this data. However, you can right-click on a course or class to bring up a small menu
that allows you to display the course or class editing forms. If the student has been
invoiced for this course, the invoice number will be shown.

The Wait List page shows the courses that this student wishes to take in the future. It is
much the same as the wait list on the Course form.

% Students:1 - 38 Alain Michaud
Selection Criteria | Student | Employer | hlisc. | Interests | Clagses  WaitList

Courge Wanted Session -
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The Wanted field will display a popup calendar if you double-click on it. The Add button
displays a list of courses, and the Remove button will remove the highlighted course

entry.



. The Company Form

% Companies:1 -0

Selection Criteria | Cormpany isc

Employees

Campany

Arwil Integrated Solutions Inc.

CAL Corporation

Canada Communication Grp.
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Cdn. WVeterinary Medical Assoc.

City of Longueuil

Kao Infosystems Canada Inc.

Kinmond Muritt Architects

MAY Canada (Technical Systern Centre)

Display Company

Create Hew Company

This form is very similar to the Student form we just explored. The Selection page,

above, works the same way.

% Companies:1 - 4 Longueuil
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Mumhber 4 Last chandged on Wed Dec 16,1993
Mame | City of Longueuil
1D | Longuewil
Address !
777 dAuvergne Country I—_ICanada -
IP'O' Box 5000 Postal Code I._I4|<4Y?
: I Fhone |514—E4E—8423
City | Longueuil
F A |514—E4E—8208
ProwiState | oC A
IR gance|| Hew |ge|ete| Print |

The Company page has both a Name and an ID field; when you create a new
company, the ID field will be filled in automatically with the contents of the Name field.
The ID field is used in other forms (such as the Student form’s Employer page) to select
a company. The Name field should be the formal name of the company. The ID field
could be an abbreviation, or used to distinguish several divisions or departments of a
large company, to make is easy for you to find in a popup list.

The Misc page has additional details. The Employees page displays a list of the

students that are employed by this company. You can’t change anything on this page,
but right-clicking on the name of a student allows you to bring up the student editing

form for that student.



5. The Instructor Form

% Instructors:1 - Elton Hammond

Instructor | Mise Schedule | Availability
Number 1 Lastchanged o Fri Mov 20,1998
Salutation IM,, City IGVBEW

First Mamea IEItnn ProviState [ oy -

Surname IHammnnd Country | ronada ,I

Address 302 Emerald Links Drive Postal Code  [c4p g

| Phone |E13-822-1925
| FAx |E13-822-?132

List Instructors to Select From |

] «|v|n]| save |cancei| new | Delete |

This form is used to maintain the list of instructors at your school. You can use the
navigation buttons to move through the instructors, or you can click on the List

Instructors to Select From button for a popup list.

The Misc page lets you record information regarding courses the instructor could teach,
plus a general notes field.

The Schedule page shows the class the instructor is (or has been) scheduled to teach.

% Instructors:1 - Eiton Hammond

Instructor Misc Schedule | Auailability
CIasleourse [glelaly] [Start |Finish |;
2 AutaCAD 14 Level 1 1 - Room 105 Mon Dec 14,1985 Thu Dec 24 19385
52 R13 1o R14 Upgrade 1 - Room 105 Mon Dec 14,1998 Wed Dec 16,1993
6 30 Studio Max Deluxe 1 - Room 105 Mon Dec 21 19853 FriJan 29,1398

Show All Classes |

Right-clicking on the Class or Course fields allows you to bring up the Class or Course
forms. The schedule only show recent and future classes; clicking on the Show All

Classes button will show all the past classes for this instructor as well.



The Availability page show the dates that the instructor has booked off.

% Instructors:1 - Eiton Hammond
Instructor | isc | Schedule Availability
Date Off Session| =~
hlon Jan 41999 Drary vi
Tue Jan 5,1999 Dy =1
Wied Jan §,1999 Dy =1
Add | Remove |

The Date field will pop up a calendar upon double-clicking. You can select a session
(Day, AM, ...) for which the instructor is unavailable. Currently the system does not use
it. It uses the date only, to block off the day on the calendar. A future release will use the
session information, as well as allowing a more flexible method of specifying the time
off, such as a range of dates, or “Every Monday”.

The Add button adds an item to the list, with today’s date. Edit the date as necessary.
The Remove button will remove the highlighted date.



6. The Class Form

IClass:1 -0 ¥ Class:2 - 7 3D Studio Max Level 2
Selection Criteria | Diata Entry | Class Motes Aftendees Selection Criteria | Class Motes | Aftendees
——— . B recards found
or this class number
HNumber 7 Last Changed on hon Dec 14,1938
I ]
Courze
|3D Studio Mayx Lewvel 2 j Classroom I 2
or else for this course NS
I j Start Ih.ﬂnn Jan 11,1999
Warkow, Har -
! AL [ [Thu Jan 14,1923
and starting on or after Obsolete [~
wed Dec 1E|1 gag j Hours REqUirEd I a0.00 Maximumsize I 2
Hours Scheduled I an.nn Current Size I &
Show Obsolete Classes & Courses v List Classes to Select From |
Clear Entries Select | New Class | Hl 1 | 4 | Hl Save |Qan-::el| New | QEMB' Print |
Update Student Data |

The Selection Criteria page lets you select classes to display in different ways. If you
enter a class number, that class will be displayed. If the class number is left as zero,
then you can select classes based upon the course they are for, or the starting date (or
both). The course popup will give you a list of courses and the date popup will give you
a calendar. The Show Obsolete Classes & Courses check box allows you to see all
courses and classes, or it will filter out those that are obsolete. If a course is obsolete,
all the classes for that course are also obsolete. Turning this off makes the list of
classes you are working with smaller, as you are now looking at only those classes that
are current.

The Clear button will clear out all the criteria so you can start again. If you leave the
fields all empty, all classes will be available for editing. When you have entered your
criteria, click the Select button to go to page 2, the Data Entry page. The New Class
button will bring up a blank Data Entry page.

At the top of the Data Entry page you are shown the number of classes that met the
selection criteria. The List Classes to Select From button or the navigation buttons
can be used to move through the records that were selected.

The Course field will pop up a list of courses for the class; the Instructor popup will
give a list of instructors to choose to teach the class. The Hours Required field will be
filled in from the information in the course table when you create a new class; you can
change it if you wish. The fields with a grey background cannot be changed. Hours
Scheduled and Current Size are updated as class sessions are scheduled on the

calendar and students are registered.



The Maximum Size field will be set by the calendar when you schedule sessions for a
new class, based on the classroom you schedule. It is taken from the value you
specified in the System Setup form’s Classroom page. You can change it if you wish,
although the system will warn you if you try to make it greater than the classroom is set
up to hold. The system will not let you register more students than the value in this field.

The New button will let you create a new class. You need to fill in the course, instructor,
and hours required, then save the information. At this time the system will bring up the
calendar so that you may schedule class sessions. We won't explore this at present, not
until after we have explored the calendar in detail.

The Class Notes page allows you to record additional information about this class.
The Attendees page is where you register students for the class.

#¢ Class:1 - 7 3D Studio Max Level 2

Selection Criteria | Data Entry | Class Motes Aftendees

Class Murmher?
Student Imvaice —
|mfar Phillip Sharp Architects
|| Diamond, Dale 10000
Greene, Stuart 10000
Knight, Alan 10000
Leduc, Jules 10006
| |Lee, Thaba

= -,

Add | Resenrel ﬂemwel Print | ln\micel

The Add button will pop up a student selection form, just like that on the Selection page
of the Student form. You can select from the list, or start typing the name into the box
below the list.

The Reserve button will pop up a company selection form, just like that on the Selection
page of the Company form. This allows you to reserve places in a class for a company,
when the company does not yet know who will be attending. The attendees list shows
this by putting the word ‘for’ before the company name, and using blue text for name.
The Remove button will remove the student whose entry is highlighted on the grid.

The Invoice field shows the number of the invoice upon which this student was billed.

This is useful for tracking who has and has not been invoiced. The Del field will have
Yes in it if an invoice has been generated, but later deleted while cleaning up old

invoices. This allows you to clean up invoices, but not lose track of who has been billed.



Right-clicking on the Student field pops up a menu of things that you can do with this
student.

Print Student Form

Editthis Student

Remowve this Student

[revoice this Student

Print Certificate for this Student

You can print a student form, which is a form with information about the student that can
be placed at his workstation so that the instructor and other students can know who he
is. You can also bring up the Student form for this student, or remove him from the list of
attendees for the class.

Selecting the Invoice ... item will bring up the Invoice form. If the student has been
invoiced already, the existing invoice will be displayed. Otherwise a new invoice will be
created for the student. We’'ll discuss invoicing later.

We have the ability to print a certificate for students. Currently, we only are set up to
print certificates for AutoDesk courses on pre-printed forms. In a future release we plan
to provide a more general facility for printing certificates.

The Print button brings up a small menu.

Print Student Form

Print Class Attendence Form
Print Certificates for All Students
Print Class List for Students

The first item prints a student form for the highlighted student, as described above. The
Class Attendance form is a printed form that the instructor can use to keep an

attendance record for the class. The Class List for Students is just a name and
address list of all the students that you can give to each student, in case they wish to
contact on another.

The Invoice button brings up the Invoice form for the highlighted student, just as
described above in the right-click menu.



7. The Calendar Form

The calendar is the heart of the School Management System. You will find that you start
up the calendar as soon as you run the program. Most other activities can be started
from the calendar.

¥ Calendar [_ O] x|
4_| classroom |1 -Room 105 v |December =] I 1998 = Today | i
Sunday Monday Tuesday Wednesday Thursday Friday Saturday
[ [ 2 ['3 | 4 [5
| 6 | 7 | 8 | 9 [10 [ 11 [12
[AcaD1aLwi2 || ACAD14Lvi2 [ACAD14Lwz |[ACAD 4Lz
ACAD 14 Lul 2
[13 [ 14 [15 [ 16 [ 17 [18 [19
e [[AcAD A Lz
- : :
p13-R14 Upgrade R13-R14 Upgrade
[20 [21 [22 (23 [24 | 25 | [26
|27 |28 |20 [ 30 [31
305 Max Deluxe
Date legend
Today [_
Holiday [N
Corflict [
* Show Busy Session Display
. Calendar Type
Save | Cancell Refreshl Print | " Show Eree Im
[ o7 [Normal r  Show All

Across the top of the calendar are controls for selecting the month and classroom that
the calendar will display. The two arrows move forward or backward one month at a
time. There is a popup for selecting a month and a spinner for the year. There is a
popup for selecting the classroom.

The date displayed in each box on the calendar can be highlighted in a different colour,
as shown in the Date Legend box. For example, the 25" is shown in red in the sample
above, as it is a holiday. The current date, the 16", is shown in yellow. A date
highlighted in light blue means that there is a date conflict for an instructor. This can
occur if you change the instructor for an already-scheduled class, and the new instructor
is already busy on some or all of the days. The Class for will warn you of this, but will let
you continue. The calendar highlights these dates as a reminder. Later we’ll see how
you can find out what the conflicts actually are.



Each class is shown in a different colour. For example, on the calendar above “ACAD
14 Lvl 1”7 is shown in red.

EKHO SMS supports four different time periods for class scheduling: all day, morning,
afternoon, and evening. The position of a class session in a date box on the calendar
indicates what time period it used. A morning session is at the top, an afternoon session
just below that, and an evening session at the bottom. An all-day session will be
positioned halfway below where a morning session would be. It would overlap the
bottom of a morning session and the top of an afternoon session if all three were
scheduled at once (which is impossible in the same classroom). For example, in the
calendar above on the 14", we see “ACAD 14 Lvl 2" in the AM, “ACAD 14 Lvl 1" in the
PM, and “R13-R14 Upgrade” in the evening. (By the way, these names come from the
Calendar Name field on the Course form — you may have to play with abbreviations to
make them fit). On the 15", you can see that “ACAD 14 Lvl 2" is an all-day session
(compare it with the day before). Although the spatial aspect of this may seem
confusing, you will quickly get used to it.

The default contents for a session box (that's what we call the coloured boxes) is the
course name. You can select different things to display by selecting from the Session
Display popup in the bottom right corner of the calendar. You can display the class
number, the instructor (useful for detecting those conflicts we talked about earlier), the
cost, the hours scheduled, and the number of attendees. The Number display is very
useful, as it displays the time period as well as the class number. Try it! You may find

number more suitable for your everyday use.

The box at the bottom to the right of the Session Display lets you select whether the
calendar should show busy sessions (those with a class assigned), free sessions (those
without a class assigned), or both. Try selecting Show Free and observe the screen. It
will now show the time slots, or sessions, available for scheduling classes. This is the
view of the calendar that the class scheduling facility uses. Note the word “Free” in each
session, as well as the colour code to show the time period (there is a legend for the
colour code near the bottom right of the calendar in this view. Also note that if there is a
class in the all-day time slot, the AM and PM slots do not show as free. Show All is

shows all of the sessions.

Clicking on a session in the calendar pops up a small form showing the details of the
class. You can have several of these on the screen at once if you wish.

Right-clicking on class session pops up a menu of things that you can do for that class.

Feschedule Class Session

Display Class Info

Display Attendees

[DE(etetiiis SEssinn

Welete sl sessians tarthiie class franths: moht
Print Calendar for this Class

Print Attendence Sheet far this Class

Edit Class

Edit Course




The first one is for rescheduling classes; we’ll explore that in a minute. Display Class
Info brings up the same form as clicking on the class does. Display Attendees pops up
a form showing the students registered for this class. Print Calendar for this Class
allows you to print a calendar just for this class. We'll look at printing in a minute. Print
Attendance Sheet ... prints the same attendance sheet as we saw in the Class form.
Edit Class and Edit Course bring up the respective forms for editing.

The Print button brings up a form that lets you specify what sort of calendar you want
printed.

I
! Humber of Copies
i " Class Iﬁ
: " Student -
" Instructor
; Student Class
o Ef ]
Instructor Classroom
| Ef ]
Print | Cancel |
|

TTETTTTITIT T e T

You may select a Standard calendar — a full calendar for the month, or one for each of
the other items shown. When you select one of the others, the appropriate popup box
will be enabled so that you can select the student, or class, or whatever. If you select a
class, there may be several pages printed if the class extends over more than one
month (class 6, for 3D Studio Max, extends into January). If you print a calendar from
the right-click menu for a class, you will get this same form, but the with the Class

option selected, and the class number filled in.



Now let’s look into scheduling classes. Right-click on one of the “ACAD Lvl 1" sessions,
and select Reschedule... from the popup menu.

% Calendar Scheduling class 2 with Instuctor Elton Hammond

4| Classroom [1-Room 105 -] [December -] | 1998 = Today | |
Sunday Monday Tuesday Wednesday Thursday Friday Saturday
[ 1 2 | | 3 | 4 | 5

.. — | e = - _

ACAD 14 Lvl 1 ACAD 14Lvl1
ACAD 14 Lul 1 v Lk v
ACAD14Lvl1 |||

[20 [21 [22 [23 [24 | 25 | lzﬁ

[acap1aLv1 ||| AcAD 14111

| 27 | 28 |29 [30 | |31

Date legend
Today | Hours Reg'd I 37.50 Scheduling
Holiday I Hours Sch'd I 37.50 [ACAD 14Lul
Conflict
" Show Busy Session Display
Spraed Calendar Type
Save | Cancell Refreshl ¢ Print | & Show Free Im
[ o6z [Normal = ¢ Showan

The title bar shows that we are scheduling class number 2, with Elton Hammond as the
instructor. The calendar now shows the free sessions, as well as the sessions for the
class being scheduled (“ACAD 14 Lvl 1”). The box labelled Scheduling also has the
class being scheduled in it. You can change the display to the class number from the
name if you wish — it may make it easier to see what is going on, as the number display
shows the time period as well as the classroom number. The number of hours that the
class requires, and the number of hours that are scheduled are shown; the latter will be
updated as you add or remove sessions.

To move sessions, we use “drag and drop”. You place the mouse over the session you
want to move and hold the left mouse key down. Drag the cursor (which now has a
small box attached to the bottom) over the free slot. Notice that the cursor shows the
time period of the slot (Day, AM, etc) when it is over a free slot so you can be sure that
you are dropping it in the right place. Try it. Drag the session from the 16™ to the free
“day” slot on the 11". But while dragging, move the mouse over some of the other spots



on the screen to see what happens. The cursor will turn into a “Don’t” symbol, and in
some places the background will turn red if a drop isn’t permitted. Now move over the
free slot on the 11" and release the mouse button. Now the class appears on the 11",
and the slot on the 16" is now free.

To add a session, drag the class from the Scheduling box near the bottom right corner
of the form. Note that in this case, the cursor has a plus sign with it, indicating that you
are adding a session. Drop it on the free “day” slot on the 17", and note that the class
now appears there, and the Hours Scheduled field has increased to 45 from 37.5 as you
added a 7.5 hour all-day session.

You can also add sessions by holding down the Ctrl key while dragging and dropping.
You can add several sessions this way; hold the Ctrl key down, then drag a session and

drop it on a slot, then drag that one to the next free slot.

If you only want to schedule in a particular time slot (e.g. Day), you can have the
calendar only show the free slots for that period by clicking on the appropriate period in
the legend box at the bottom right of the calendar. Clicking on the period again will
display all the free slots.

You can add sessions to another month by selecting that month. Click the right-arrow at
the top right to move the calendar to January 1999. Note that the 4", 5" and 6" dates
are shown in red, as holidays. These are days that the class instructor, Elton Hammond,
has booked off (remember when we worked on the Instructor form?), and you can't
schedule a class on one of those days. Now drag the class from the Scheduling box to
a free slot.

You can add a class to another classroom as well, if necessary. Just select another
classroom, the drag the class from the Scheduling box to a free slot. Try it.

To delete a session, right-click on the session and select Delete Session from the
popup menu. You can delete all the sessions for the month by selecting Delete All
Session ... from the menu.

Click on the Show All option. Notice how the busy and the free slots are shown. The
class being scheduled is always shown with a white background to distinguish it from
the others.

Click on the Save button to save your changes, or on the Cancel button to erase any
changes you have made. The display will return to the showing of busy sessions for the
current classroom. When you save, the system will warn you if you have not scheduled
enough (or have scheduled too many) hours. If you have deleted all the sessions for the
class, it will inform you of this as well.

If you have the Class form for this class open while you are scheduling, it will change to
reflect the new schedule. The start and finish dates, and the number of hours scheduled
will be updated automatically.

Remember how in the discussion of the Class form we mentioned that when you
created a new class and saved it, the calendar would appear? It will appear in
reschedule mode, with the new class number in the Scheduling box. Select the proper
month, year, and classroom. Then drag and drop from the Scheduling box to add
sessions. When you save, the Class form will be updated with the classroom, start and
finish dates, and hours scheduled. Simple!



As well as the normal calendar, which shows all classes for the month, it is possible to
display specialised calendars. This is where that little green Drag Zone box that you
saw on the various other forms can be used. If you drag from the Drag Zone of the
Instructor form to the calendar and drop there (the calendar will turn green to show that
it is legal to drop an instructor), you will get a calendar that show those classes that the
instructor is teaching. If you drop a student, or a course, you will get the appropriate
calendar. To return to a normal calendar, click on the Calendar Type box and select
Normal.

The calendar is the focal point of the EKHO system; play around with it until you are
comfortable.



8. The Invoice Form

Invoices can be created in two ways. You can generate one automatically from the
Class form’s Attendees page, or you can create one manually. You can also edit an

existing invoice.

When you generate an invoice from the Class form, the invoice will be addressed to the
student you've selected, and will have the course name filled in. The student will appear
on the invoice details page. Try it. Bring up the Class form, and select class number 7,
the 3D Studio Max class that we were working with before. Go to the Attendees page,
select “Leduc, James”, and click the Invoice button. The following form will appear:

¥ Invoice :1
Selection Criteria Invoice Header | Invoice Details
Numherl 10006 Date [5un Dec 20,1998 j Class I?
B Comment to go on Invoice
Mg IJuIes Leduc Bill Emplayer ;[
A .  Bill Student
ress IT52 Limoges Rd.,  Other
City ILimoges, _|
Provistate |ON =]
Coauntry ICanada j Course |3D Studio Max Lewel 2
Postal Code | ks 2MD Discount % |
ATTH | GST | 7.00
) Inwoice Total
Text for discount figld Ontario PST I 8.00
if paid hefore start of class I $1,435.00
M4 L4 Save |Qancel| New |gelete| Print |

The student has been set up as the addressee. Clicking on the Bill Employer option
will change the addressee to the student’s employer. Clicking on the Other option will
add two buttons to the display allowing you to select a student or a company from a list;
the lists are the same as they appear on the selection pages of the Student and
Company forms. You can also just type in a new addressee.

The Course field will be printed on the invoice; you can change it. There is provision for
giving a discount. If the Discount field is filled in, then the text in the Text for discount
field box will be printed on the invoice along with the discount. The tax fields that show
on the form depend on what you have entered in the System Setup. The example
above shows Canadian GST and Ontario PST. If the rate for a tax is zero, then no entry
will appear on the invoice for that tax.

Now click on the Invoice Details tab.



% Invoice -1

Selection Criteria Invoice Header Invoice Details
Student or ltem Cost GET |Ontari |~
Jules Leduc $140000W T

Add Student Add Htem Remove

The student has been automatically added to the invoice details, along with the default
course cost. Many times you will be billing an employer for several students who are
taking the same class. You can add additional students from the class to the invoice by
clicking on the Add Student button. This will pop up a list of those students who are
registered for this class that have not yet been invoiced. Selecting one will add that
student to the invoice, with the cost as filled in on the Header page. You can change the
cost if you wish.

The Add Item button will add a blank line to the details; you can fill this in with anything
else that you might wish to bill for, such as manuals.

Note the columns headed GST and Ontari. These are used to specify what taxes are
applicable to each item. There will be one column for each tax shown on the invoice
header page. Double-clicking on the box will turn the check mark on and off. The text in
these headings are taken from the Invoices page of the Setup form.

When you print an invoice in the trial system, you will get an invoice form set up for The
EKHO Institute. When you purchase a system from EKHO, we will customize the
invoice for you at no extra charge, using your graphic logo if you have one, and any
other pre-printed information you wish.

At the same time as you are printing the invoice, the system will let you print additional
material to send out to the student.

Now go back to the Invoice Header page, and click the Print button. A small form will
appear, allowing you to chose what you wish to print.



Select Items to print

[~ Print Envelop

I~ Print Calendar

™ Print Course Outline
[~ Print Welcome Sheet
[~ Print Map

Print Cancel

The default is to print only the invoice. You can select other items to print: an envelope
with the invoice addressee on it, a calendar for each student, a course outline, a general
welcome sheet and a map. You create the map, welcome sheet, and course outline
using your favourite word processor and graphics package, and then print each to a file;
store the file in the same directory as the EKHO system. The map needs to be called
MAP.PRN, and the welcome sheet must be called WELCOME.PRN. A course outline is
given a name consisting of the name of the course, as shown on the Course form (not
the formal name or the calendar name), followed by “.PRN”. For example, for the course
on this invoice, the name would be “3D Studio Max Level 2.PRN". Note that spaces are
allowed in names in Windows 95 and Windows NT.

When you save the invoice, the Class form’s Attendees page will be updated to show
the invoice number next to the student(s) that were on the invoice.

You can create a new blank invoice by clicking on the New button. In this case, the
header page has two buttons to let you select an address from either the student or
company lists, or you can enter an addressee manually.

If you fill something in to the Course field, that information will appear on the invoice in
a line reading “Re: ...” You can also add other text to the invoice using the Notes field.
On the Details page, the only option is to add items, since there is no class associated
with the invoice. An item, of course, can be anything you wish to enter.

You can edit an existing invoice by clicking on the Selection page. This is also the page
that comes up when you click on the Invoice button on the toolbar.

Select an invoice from the popup list, then click on the Display Invoice button.

Note regarding invoice numbers: in the system setup, you can assign a starting invoice
number to fit in with your existing accounting system.



9. The Reports Form
Click on the Reports button on the toolbar to bring up the following form:

Generate a WINFAX table =]

Instructar List with Classes
Invoice Repart far a Month
Mon-Invaiced Attendees

Waiting List

r Output Destination

 Print Preview

& Send to Printer Run

" Send to File Close |

This form gives you a list of reports that you can print, or preview on the screen, or have
printed to a file. “Generate a WINFAX table” does not actually print anything; it
generates a list of all students in a form suitable for use by WINFAX Pro, a fax program.

It can be used to send out mass FAXes to your students.

More reports will be added to the system as our customers request them. These are the
ones that we have found useful in the years we have been running the system. We had
others, such as complete student lists, but with 3000 names on our list, that's not too
useful.



10. Printing Labels

Selecting the Print Student Labels item from the File menu brings up the following
form:

¥ Print Student Labels:1 M=l 3

Student who have taken
selected courses

Students who are interested in
selected courses

Lahels Used

r:-\. +
O 210 (1" = 47)
© 3%7 (15" % 258 ")
~ 3%10 (1" x 2 5/87)

Generate Lahels |

Cancel |

This is used to print mailing labels. We support the four sizes of label sheets shown;
these are the most popular sizes from the Avery catalogue. The list shows the number
of labels across and down, and the size of each label. Use 1.5” high labels if you can,
as they have more room for the address.

You can print labels for students who have taken specified courses in the past. This
would be useful, for example, to market an Advanced course to those who have taken
the Basic course. You can also print labels for students who have expressed an interest
in specified courses (via the Interest or Wait List pages of the Student form). Clicking on
either brings up the following form for you to select the courses:

Mowver

3D Studio Max Delue |=] 3D Studio Max Level 2 |=]
30 Studio May Level 2 Add | AUtaCAD 14 Level 2
3D Studio Viz
autaCAD 14 3D Add Al |
AutoCAaD 14 Level 1
R1Z to R14 Upgrade ' Remove |
R13to0 R14 Upgrade
\isual Basic for Applications Remave All |
0K |
J Cancel | J




The “mover” form allows you to select courses from the left window and move them to
the right window. The courses in the right window are those that will be used for the
mailing. You can move courses between the two windows by selecting with the mouse
and clicking the Add or Remove buttons, or by double-clicking. You can add or remove
all the courses at once. You can drag and drop courses from one window to the other.
You can select several courses at once by holding down the Ctrl or Shift keys when you
click with the mouse. Play with the mover to get the feel of it. Click OK when you have

made your selections.

Click the Generate Labels button to print the labels. If you are printing labels for
students who have taken certain courses you are asked to enter a date (it is a calendar
popup) before which the students must have taken the course. This allows you to avoid
sending mailings to very recent students.



11. Other Features
The File menu provides access to several other features:

Print Setup. This brings up a dialog box to allow you to select the printer to be used
for subsequent printing operations

Print Reports. This is the same as the Reports button on the toolbar

Database Utilities. This brings up a form to perform system maintenance activities
on the data files. The data files can have their structures updated if this is required
by a new release of the software. Their indexes can be rebuilt, and the files can be
packed to remove deleted records. There is also a file repair utility that can recover
files that have been damaged when a workstation or server crashes. These utilities
are normally only used upon advice from EKHO Tech Support.

System Setup. This brings up the setup form that was discussed in the section on
installation

User Preferences. This allows the user to select between production and test data.

Activate. This provides the ability to enter an EKHO-supplied key to activate
optional features of the software.

Backup Data. This will back up the data files to a user-selected directory in a
compressed (‘zip’) format. Each backup file name contains the date and time of the
backup, making it possible to keep a set of backups (one each day, for example).
Login. This brings up the login form so that a different User Name (normally with
different privileges) may be used. All other forms are first closed.

Special. This will run an EKHO-supplied program to perform maintenance activities
on the system. It should only be used upon instruction from EKHO Tech Support.
Error Log. This will bring up a form that displays the contents of the error log. If the
system encounters problems, it will normally display a dialog box telling the user of
the error, and giving him a choice of things to do — normally, the user would chose
the option to quit the existing form. The system also logs details of the error. EKHO
Tech Support may request you to bring up the error log form and read off some of
the information. It provides the ability to E-mail the log file to EKHO Tech Support.
Note that for this feature to work, your E-Mail program must support the Microsoft
MAPI interface, and be set up as the default MAPI mail client. We have successfully
used Eudora Pro (Version 3 or later), Microsoft Outlook and Outlook Express, and
Microsoft Exchange as MAPI mail clients with this system.

Exit. Terminates the operation of the EKHO SMS.

This is the end of the tour of the EKHO School Management System. In order to use
your own data, Select User Preferences from the File menu, and uncheck the Use

Test Data box. Exit from the system by selecting Exit from the File menu, or by clicking
on the Close box in the top right corner of the screen.






